Volunteer Scheduler Pro

Quick Start Guide – Adoration
Introduction
Welcome to Volunteer Scheduler Pro! This Quick Start Guide was created specifically with scheduling
Adoration in mind and will guide you through the process of creating schedules, publishing
opportunities and filling shifts in just a few easy steps. We recommend that you print this guide by
choosing “Print…” from the File menu and read it while getting started with VSP.

Step 1: Defining your database
When you launch VSP, it’s helpful to re-label the headings on the left-hand side to more accurately
reflect Adoration schedules.
Click the “Edit” menu at the top of the VSP window and select “Change label used for ‘Volunteer’”
Change the word “Volunteer” to “Adorer” (enter the singular form of the word and VSP will pluralize
as needed).

Step 2: Setting up your Job
We’ll start by setting up our “Adorer” job. Later on, you will be able to specify how many Adorers
should be scheduled at each time.
To create a job, first click on the Jobs pane on the
left-hand side of VSP’s main screen (the screen
which appears when you launch the program). Then
click the “New Job…” button. In the dialog that
appears enter a name for the new job (e.g. “Adorer”).
To ensure all volunteers are added as an Adorer,
select “Qualify new adorers for job by default.” There
are several other options available that affect how
positions appear and are scheduled. These options are
not discussed in this Quick Start Guide, but you may
click on them inside VSP to see a short explanation of
what each option does.

Step 3: Creating a schedule and shifts
After you've entered your Adorer job, click on the Schedules pane on the left-hand side of VSP's main
screen and enter the start and end dates for a schedule. Clicking the calendar icons to the right of the
date fields will produce calendars from which you can select the dates. After you have entered your
schedule’s start and end date, click the “Create…” button. A window will open that contains a blank
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schedule spanning the date range you specified.
Now you'll want to create your shifts:
1.

Click on a day in the calendar on which one of your shifts take
place.

2. At the top of the schedule window, click the “New Shift...”
button.
3. In the dialog that appears, set the start and end time for the shift
by clicking on the hours or minutes and typing in the correct
value – or by using the arrows next to each value. Usually
Adoration shifts are one hour in length, every hour.
4. If the shift repeats on other days of the week, click the dropdown for “Repeats” and then click on the days of the week.
a. (The other instances of this shift will automatically be
created for you, both in this schedule and in your future
schedules.)
5. Next, specify how many Adorers are required for Adoration at
this shift. Select the Adorer job in the list by clicking on it and then type the number of required
Adorers for that shift. (You can also use the arrows that appear below the job list to adjust this
number.)
6. Once you have configured this shift for the correct times, days, and required Adorers, click OK.
Then repeat this process to set up 24 separate, one-hour shifts for adoration.
When you have finished creating all your shifts, choose “Save” from the File menu at the top of the
schedule window. A dialog will open asking you to enter a name for the schedule. Be sure the box is
checked to “Make this schedule live now” and select the option to “Just use the default layout and
options for now,” and then click OK.

Step 4: Entering your Adorers
Now that the schedule is saved, it’s time to get your Adorers into the database. There are three ways to
do so:
1. Import existing Adorers’ contact information from a .csv (Excel) or .txt file, or by
synchronizing with an existing Church Management Software. For help importing Adorers,
please refer this article in VSP’s Complete Documentation. For help with Synchronization,
please feel free to contact us.
2. Email your organization’s enrollment form to a list of contacts. As people enroll, they are
added as a volunteer to the database and can sign up for shifts at the same time. See below for
more information.
3. Enter your Adorers’ information manually one volunteer at a time. See the section below
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for information on manually entering Adorers.
Using the Enrollment Form
VSP’s enrollment form is an online form that potential Adorers can use to both register their personal
contact information to be added to your database and sign up for open positions. To see the enrollment
form, click on the Web Terminal pane on the left-hand side of VSP's main screen. At the top of the
pane, click “Web Terminal Settings” and then click the Enrollments pane on the left. The Enrollment
URL at the top is the direct link to your form, which you can send to Adorers.
For more information on customizing enrollment forms, please refer to this section of the
documentation. There is also a video tutorial on the topic. Enrollment forms are a great way to invite
Adorers to sign themselves up for one-time shifts. However, if you need volunteers to be placed on a
repeating assignment, you will want to do that as the administrator as shown below.
Manually entering Adorers
Click on the Adorers pane on Volunteer
Scheduler Pro’s main screen and then click the
“New Volunteer…” button for each volunteer
you are scheduling. Enter the first and last
name of the new volunteer and add his or her
email and contact information. You can create
and enter values for custom fields by clicking
the “Edit custom fields...” button. By default,
all Adorers will be qualified as an Adorer,
thanks to the setting we used when creating the
Job above.
The rest of the settings on the right-hand side
of the dialog are used to track volunteer
availability and preferences. You will not
necessarily need to use these sections if you
are primarily having Adorers assigned to
repeating shifts. However, it may still be beneficial to enter Shift Preferences and Unavailable
dates/times to help determine what type of sub requests people will receive. For example, if an Adorer
has 8AM – 9AM and 9 AM – 10 AM as shift preferences, and selects “Schedule only at these shifts”
then by default they will only receive substitute requests for those times.
When you are finished editing this volunteer’s profile click the OK button. (For a detailed explanation
of all the options available in the Edit Volunteer dialog, refer to VSP's Complete Documentation.)

Step 5: Scheduling Adorers
Once you have created your schedule and imported/entered Adorers, you are ready to start scheduling.
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The most common method of scheduling Adorers is to scheduling them with repeating
“preassignments” that occur at regular intervals. To do so:
1. Open the saved schedule you created by clicking on the Schedules pane on the left-hand side of
VSP's main screen, selecting the schedule, and then clicking the “Open Schedule” button.
2. Then click on a day in the calendar view that contains a shift.
3. Click on one of the empty positions in the shift and you'll see that the volunteer list on the right
side of the window shows the Adorers that are eligible and available to fill the selected position.
VSP displays Adorers with scheduling conflicts in red and orange. For example, if a volunteer is
already scheduled at that shift, his name will appear red to warn you not to schedule them in the
selected position.
4. To fill the position with one of the Adorers in the list, double click or drag and drop the
volunteer to assign them.
5. Once the volunteer has been assigned, you will see a “Repeats” bubble appear next to the
assignment. You can check this box to indicate that the assignment will repeat at a regular
interval (e.g. every week, every other week, etc.).
Introducing Adorers to VSP
When you are ready to introduce VSP to your Adorers:
1) Go to the Announcements pane on the left side of the program window.
2) Click on the “Templates” button at the top of the window, choose “Preconfigured” and from
there select, “Introductory email – schedule finalized” and “Use.”
3) We recommended adjusting this template for Adoration by letting people know they have been
assigned. We do want to leave the Web Terminal tokens, as these will provide Adorers with
their usernames and passwords to login; they are like mail-merge fields and will populate
automatically.
4) Review the subject line, and then click the “Preview” button. Click OK in the token options
window that will appear. In the list of names that appears on the right, click on a name once to
preview how the email will look for that individual.
5) When ready, click the “Send” button to send this as an email, and Adorers can begin logging in
online to view their schedule, requests substitutes, etc.
6) For any Adorers without internet access, use the “Print” option from the drop down to the right
of the sent email and select, “Copies for those without internet access.” These Adorers may
continue to reach out over the phone, in person, or whichever method they have been most
comfortable with, and as the scheduler you can manually place them or adjust assignments.
4

Step 6: Setting up the Web Terminal
As Adorers sign up for positions online, these changes will appear inside of VSP as web forms. To
allow assignments and enrollment forms to process in real time, it is recommended you turn on the
automatic processing option for web forms:
1. Go to the Web Terminal pane in VSP and click the “Web Terminal Settings…” button at the top.
2. In the Settings window that opens, click on Enrollments on the left. To process new Adorers and
their assignments automatically, check the option for “Automatically process enrollment
forms.”
3. From the same window, click on Assignments on the left, and check a similar “Automatically
process assignment forms” to allow self-sign up’s in real time.
4. Click on the Swap Requests heading on the left and check the “Automatically process swap
requests” option here to process these in real time as well. A pop-up will confirm if you would
also like Swap Accepts to be automatic – select “Yes.”
5. Click OK in the Settings window, and then click the Commit Changes button to save these
changes.
Auto Reminders
You can configure VSP to send automatic email to Adorers before they are scheduled to serve:
1. Go to the Web Terminal pane in VSP and click the “Web Terminal Settings…” button at the top.
2. In the Settings window that opens, click on Auto Reminders on the left.
3. Check the box “Send automatic email reminders.” and optionally click on the number of days to
adjust how early a reminder email is sent.
4. Where the subject line for the reminder appears, feel free to customize, and click the “Edit
Email Body…” button to customize the reminder email that is sent out. (Note: the tokens in this
email affect the deliverability of the mail, and we recommend adjusting the text around the
tokens only.)
Customizing the Web Terminal
The text we see inside of the program, when we click on the Web Terminal pane on the left, is the same
Adorers will see when they login. First it is a good idea to use the “Login As..” button at the bottom,
pick any name and login as someone (if you have manually entered any Adorers). This will take you to
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the login page so you may see the Web Terminal from a volunteer’s perspective.
Within the program, from the Web Terminal pane click on any of the text in the tabs to change and
customize for your organization.

Conclusion
You’ve just seen how easy it is to create schedules, publish opportunities and fill shifts using Volunteer
Scheduler Pro. The program also contains hundreds of other features that were not covered in depth in
this Quick Start Guide. Highlights include VSP’s Announcements, hours scheduled reporting,
attendance tracking, text message blasts, and more. For an inventory and explanation all of VSP's
features please refer to the complete documentation. Please do not hesitate to contact us as questions
arise. We are happy to help you get started with VSP and make sure that all your scheduling needs are
met.

6

